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User Guide 

Mitsubishi Software V1.0 
 

 

CAUTION 

 
All TuneBoy products are powerful tools that enable the user to change 
nearly all aspects of the program encoded into the motorcycle's ECU 

(Engine Control Unit). We cannot be held responsible for any direct or 
consequential damage to the motorcycle or any third party as a result of 

making any changes to the ECU programming.  To the fullest extent 
permitted by law, TuneBoy Pty Ltd will be under no liability to the 

Customer whatsoever for any injury, death, damage or direct or indirect 

or consequential loss (including without limitation, pure economic loss, 
loss of profits, loss of business, loss of use, loss of data, computer 

downtime, depletion of goodwill, business interruption, increased 
purchasing or servicing costs, loss of opportunity, loss of contracts and 

like loss) howsoever caused or arising out of or in connection with: 
• the sale or supply of any TuneBoy product,  

• any statement made or not made or advice given or not given by or 
on behalf of TuneBoy, including as to compliance with legislation or 

regulation, 
• use or misuse of any TuneBoy product, 

• Any use made or resale or on-supply of any TuneBoy product.  
 

This software and equipment is provided for use in closed course 
racing.  Use of this software and equipment to modify mapping may 

violate local laws and EPA regulations.  This is not for road use. 

 
The TuneBoy product reprograms the original ECU of the motorcycle. Any 

use of a TuneBoy product may invalidate a motorcycle's warranty. 
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INTRODUCTION  
 
There are two new softwares from TuneBoy specifically for the Mitsubishi ECU of the Ducati 
and MTS 1200. 
 

• The FlashMitsubishi software is used to load maps and trim files into the permanent 
flash memory of the ECU. 

• The TuneBoyTrim software is used to adjust the temporary copy of the trim tables.  
This is also used for data-logging and processing data-log files. 

 

 

1. MAP FEATURES 

 
Several new features have been added to the Live TuneBoy maps for the 

Multistrada 1200 and Diavel.  These include the following: 
 

1. Real-time adjustment of fuel and ignition trims while the motor is running; 
2. Auto-tuning in conjunction with Innovate LC-1 wideband O2 sensors 

(available from our website); 
3. Electronic cruise control. 

 
The fuel and ignition trim maps have 24 RPM points and 12 throttle position or 

manifold pressure points. 
 

The cruise control uses a PID control loop to control the speed of the motorcycle. 

This is the same as most automotive cruise control systems and this can control 
speed to within 3kph over almost any road conditions. 

 
  

 

2. MAP TYPES 
 

CAUTION 
For the Diavel and Panigale it is very important that you use the 

correct map for your region. The Diavel and Panigale have different 
maps for the USA, Japan and others (EU, AU, SA, NZ). 

 
Using the USA map for a bike in a different region will prevent some functions 

from working correctly.  
 

For example: the USA Diavel map will make the indicators activate instead of the 
brake light when the brakes are applied. This will also prevent the cruise control 

from turning off when brakes are applied.  
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2.1 O2 Disable Maps: 

The simplest map is the O2 disable map. This simply turns off the O2 sensors on 

the bike. This allows tuning over the entire RPM and throttle range for people who 
want to use a piggyback fuel computer. 

 
You cannot apply trim tables to this type of map and it does not come with cruise 

control.  
 

These maps have a name ending in O2_Disable. 
 
2.2 Cruise-ONLY Maps: 

The next map type is the Cruise-ONLY map. This map type adds the electronic 
cruise control without changing any other aspect of the mapping. This map does 

not turn off the O2 sensors on the bike. This map type does not support the 
speed ‘nudge up/down’ buttons as these require use of the O2 sensor plug. 

 
You cannot apply any trim tables to this type of map.  

 
These maps have a name ending in Cruise_Only. 

 
 
2.3 Live Tune Maps: 

The next type of map is the tuning map. These maps allow real time adjustments 

to be made for fuel and ignition. You can apply trim maps to this type of map. 
The tuning map should be used when mapping a bike on a dyno or when using 

the data-logging to record air/fuel ratios while riding the bike on the street or 

track.  
 

These maps have a name ending in Live Tune. They do not have cruise control. 
 
2.4 Cruise Control Map: 

The final map type is the cruise control map. These maps allow live-tuning of the 

fuel and ignition maps. You can load trim maps into this type of map. This map 
type can do everything the tuning map can do except for connecting a wide-band 

O2 sensor to the standard O2 plugs. This is because the rear (MTS1200) or front 
(Diavel) O2 sensor plug is used to connect the ‘set’ and ‘nudge up/down’ buttons 

for the cruise. These buttons allow the cruise control to be activated to hold speed. 
Once the cruise control is activated they allow the cruise speed to be increased 

and decreased in 1 kph increments. 
 

These maps have a name ending with Cruise Control.   
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3. SET-UP 
The first step is to install the software on your PC. If the setup program does not 
start when you put the CD in your CD drive you should open Windows file 

explorer and run the setup.exe program from the root of the CD drive. 

We recommend accepting the default settings as these will help with any problem 
solving if you have to contact support. 

 
Once the TuneBoy software is installed you should run the LogWorks3Setup.exe 

from the root of the CD. This will install the drivers for the WB-01box if you need 
to connect this to the PC using a USB cable. 

If you are only connecting to the PC using WiFi this step is not required. 
 

 

 

4. INSTALLING THE FIRST MAP  
 
The first time you load a map into your bike you will have to do several steps. 

These require a connection to the internet and the user ID and password you 
received when you purchased the software. 

 
The User ID and password are required to unlock the ECU. This will have been 

emailed to you when you purchased your Kit. 
 

1. Connect the WB-01 to the diagnostic connector on your motorcycle. This is 

located under the seat on both the Diavel and Multistrada. 
 

2. Connect the WiFi on your PC to the WB-01 or plug the USB cable between 
the WB-01 and PC.  If you are using the USB cable you should have installed the 

drivers for the WB-01 as part of the LogWorks install.  
 

When connecting via WiFi you will see a WiFi network with TUNEBOY_nnnn where 
nnnn is a number unique to your WB-01. 

 
3. Turn the motorcycle ignition ON and start the FlashMitsubishi program on 

your PC. 
 

You should see the following window displayed: 
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4. Click the “Select Tune File” button to select an initial tune file to load into 

the ECU.  

 
 

The following screen is shown to select the tune file: 
 

 
 
 

Once you have selected a tune file the following screen is displayed: 
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5. Click the “Prepare ECU” button and the program will start a download to the 
ECU. The message “Erasing Flash” will be displayed as is shown in the next 

screen shot: 

 
 

 
 

Note: If the message still has “Idle” displayed you should close the program and 
repeat this step. 

 
Once the flash memory is erased the screen will show the percentage data 

transfer as shown in the following screen shot: 
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If the “percentage complete” stops incrementing before you get to 100 % you 
should repeat the process. If this happens more than once you should repeat this 

step using the USB cable instead of a WiFi connection to the WB-01. 

 
Once the download is complete the following message will be displayed: 

 

 
 
6. At this point you turn the bike off, click “OK” and then click “Exit” on the 

main screen. 
 
7. Turn the motorcycle back on after waiting at least 30 seconds. 

 

8. Start the FlashMitsubishi program again. 
 

A pop-up screen will now be displayed asking you to turn the bike off and on 
again. 

 

 
 

9. Click “OK” and then click “Exit” to close the FlashMitsubishi program. 
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10. Turn the motorcycle off and on again, waiting 30 seconds between 

turning the motorcycle off and turning it on again. 

 
11. Start the FlashMitsubishi program again.  

 
The following screen should be displayed. The ECU serial number displayed will be 

unique to your motorcycle: 
 

 

 
12. Click the “Cancel” button and exit the program. 

 

13. Turn the motorcycle off and disconnect the WB-01 from the motorcycle.  
 

Make sure your PC has connection to the internet; the next step does not require 
a connection to the motorcycle. 

 
14. Start the “FlashMitsubishi” program again, the “Key Generation” popup 

screen shown above will be displayed again. 
 

15. Enter the user ID and password that have been supplied to you via email 
and click the “Generate key” button. 

 
The user ID should be the email address used when you purchased the product. 

The password will have been sent to you in an email. 
 

Keys Types:  
Make sure you have the correct type of key selected. By default this screen has 
the full cruise control and tuning key selected. If you have only purchased a 

tuning key, cruise only, or O2 sensor disable key you should change the selection 
to reflect the key type you purchased. 

 
The option for different key types is intended for dyno shops and dealers. If you 

are a customer working on your own bike you will most likely have the Tuning 

and Cruise key. 
 

 
You will now get a pop-up message as per the screen shot below: 
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16. Take note of the key number that is displayed. You will need this if you 
need to install the software on another PC. 

 
17. Stop the FlashMitsubishi program and reconnect the WB-01 to the 

motorcycle and to the PC. 
 

18. Turn the motorcycle on and start the FlashMitsubishi program again. This 
time you will see a serial number but you will not be prompted for a key. This 

shows that the key has been added to the registry on your PC.  
 

The following screen will be displayed: 

 

 
 
19. Click “Select Tune File” and select the tune file you want to load into the 

ECU. 
 

If you only have a key for the O2 disable function you can only download maps to 

disable the O2 sensor function. If you have a Tuning key you can download the 
O2 disable maps and the Tuning maps. If you have a key for the Cruise control 

you can download any tune file. 
 

After you have selected a tune file the following screen will be displayed: 
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If you have been provided with a trim file you can apply the trim file to the tune 
by clicking the “Apply trim table to tune”. This will display a file open box.  

 

20. Select the trim file you wish to load. After you have selected a trim file the 
button will be greyed out as shown in the following screen shot: 

 

 
 

Passwords: 
The password field is used to protect against unauthorized access to your bike if 

you leave the WB-01 on the bike while riding. You can enter any number from 0 
to 65535 as a password. Please make note of your chosen password for future 

reference: 
 

My password is: __________________________ 
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21. Once you enter a password, click the “Flash map into ECU” button. This will 
again erase the flash memory in the ECU and program the completed map into 

the ECU.  
 

The following screen shot shows the download in progress:  
 

 
 
 

After the “Download Complete” message is displayed you are ready to ride the 
motorcycle or tune using the TuneBoyTrim software. 
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5. SET-UP OF THE INNOVATE LC-1 WIDEBAND 

O2 CONTROLLER 
 

CAUTION 
The Oxygen Sensor when used in this device gets very hot in 

operation. Do not touch the hot sensor. Do not let a hot sensor 
touch a combustible surface. Do not use the sensor with or 

near flammable liquids or gases. Failure to heed these 
warnings may result in severe burns, explosions or fires. When installed 

in the exhaust, the oxygen sensor MUST be connected and operating with 
the LC-1 whenever the vehicle is running. An un-powered oxygen sensor 

will be quickly damaged when exposed to hot exhaust gases. 
 

With the addition of an Innovate LC-1 wideband O2 
controller you can make use of the new real-time 

mapping to allow auto-tuning of the fuel map. 
 

The LC-1 can be connected to the WB-01 WiFi box 

using the supplied connector or it can be connected to 
the O2 sensor plug on the motorcycle. 

We recommend connecting directly to the O2 sensor 
plug on the motorcycle.  

 
If you purchase the LC-1 as part of a kit we will put 

the correct plug on the LC-1 to directly plug into the 
wiring loom. 

 
When the LC-1 is connected in this way it is only 

powered on when the motor is running. This is 
important for protecting the O2 sensor as the sensor 

can be damaged if it is exposed to the moisture that 
can build up in the exhaust system as it cools down. The moisture is not a 

problem if the sensor is cold when the motor is started. 

 
You can connect any wide band O2 controller to the O2 sensor plugs on the bike. 

The only requirement is that the output of the wide band controller is 0 volts for 
10/1 AF Ratio and 5 volts for 20/1 AF Ratio. 

 
1. Start the TuneBoyTrim program.   

 
When this program starts you will see a screen similar to the image below: 
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Note: Message at the bottom of the screen “Reading map from ECU”. 
 

2. If you have entered a password on the FlashMitsubishi program you will be 
prompted for this password again when you start the TuneBoyTrim program. This 

password is your chosen number between 0 to 65535. You will only be asked for 
this once. The number will be remembered the next time you start the 

TuneBoyTrim program. 

 
3. Once the program has read the trim map from the ECU you will see a 

message  
“Map Read Complete”, or a pop-up window asking if you want to replace the data 

in the ECU with the data from the PC.   
 
If you click “No”, the data from the ECU will replace the data in the TuneBoyTrim 

program.  

 
If you click “Yes”, the data from the TuneBoyTrim program will replace the data 

in the ECU. 
 

Example: 
If you are working on the dyno and need to stop for a break you should go to the 

“File” menu and select “Save Trim File”, enter a file name and save the file. 

When you want to start working on the dyno again you should start the 
TuneBoyTrim program and select “Open Trim File” from the “File” menu. 

This will open the file and display the trim values as they where when you saved 
the file. 
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4. Turn the ignition on and the TuneBoyTrim program will ask if you want to 
replace the data. Click “Yes” and the program will update the data in the ECU with 

the data saved in the trim file. 
You can now resume the tuning work without needing the reflash the ECU. 

 
Note: The first time you connect to the ECU with the TuneBoyTrim program you 

should click “No” to make sure the data you start working with matches the data 
in the ECU. 

 

 

6. TABLES IN TUNEBOYTRIM PROGRAM 
 
The four tables available in the TuneBoyTrim program are: 

• Fuel TP Trim (F) 
• Fuel TP Trim (R) 

• Fuel MAP Trim (F) 
• Fuel MAP Trim (R) 

• Ign Trim (F) 
• Ign Trim (R) 

• A/F TP (F) 
• A/F TP (R) 

• A/F MAP (F) 
• A/F MAP (R) 

• A/F Target TP 

• A/F Target MAP 
 

6.1 Fuel Trim Throttle Position (TP) and Manifold Air Pressure 
(MAP), F/R 
These tables contain the fuel trim map values for front and rear cylinders. The TP 

tables are used when the ECU is mapping based on throttle position. The MAP 
tables are used when the ECU is mapping based on manifold pressure. “F” 

indicates the table is for the Front cylinder.  “R” indicates the table is for the Rear 
cylinder.  

 
To change the values in the cells select the area you want to change and use the 

PageUp and PageDown keys on the keyboard.  
 

The values in the table are percentage adjustments. These values are applied to 
the main fuel tables once the ECU has looked up the main fuel table. 

 

Example,  
+5% in a trim table will increase the fuel delivery by 5%,  

-5% in a trim table will decrease the fuel delivery by 5%. 
 

Any adjustments to these tables will be sent to the ECU within a second and the 
result should be seen in the air fuel ratio.  
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You should not need to adjust the MAP tables as the base program in the ECU has 
been changed to restrict the manifold pressure mapping to the area from 0 to 

2.5% throttle up to 5000 RPM.  
 

All mapping on the dyno should be done with the TP tables. 
 

 

6.2 Ignition Trim, F/R 
These tables are for adjusting the ignition advance for the front and rear cylinders 

Values in these tables are in degrees of ignition and are added or subtracted from 
the main ignition map values used by the ECU. 

 
To change the values select the area you want to change and use the PageUp and 

PageDown keys on the keyboard.  
 

Changes to these tables should only be done on a dyno that can show horsepower 
while holding a fixed RPM. 

 

If you are on a dyno that shows horsepower while holding RPM you can adjust the 
ignition trim while watching the horsepower reading on the dyno. If you add 

ignition advance and the horsepower increases, this is good.  Once you get to the 
point where adding ignition does not increase horsepower you should back off the 

ignition to the point that made the most horsepower with the lowest ignition 
value. The reason for this is that the power will plateau for a number of degree’s 

(up to 10 degree’s) before the ignition advance starts to cause detonation and a 
reduction in power. 

 

6.3 A/F Throttle Position (TP) and O2 Sensor Input 
If you have an Innovate LC-1 wideband O2 controller connected this table will be 

filled in with the average A/F (Air/Fuel) ratio from the LC-1 when the throttle 
position and RPM are within +/- 25% of the exact cell location. 

 
For example, if the LC-1 A/F ratio is 13.5/1, the RPM is at 2600 RPM and throttle 

position is at 45%, the value 13.5 would show in the 40% throttle 2500 RPM map 
location. 

 
The TuneBoyTrim program uses these measured values in conjunction with the 

target A/F values to work out the amount of trim required to correct the fuel map. 
 

6.4 A/F Manifold Air Pressure (MAP) and O2 Sensor Input 
If you have an Innovate LC-1 wideband O2 controller connected this table will be 
filled in with the average A/F (Air/Fuel) ratio from the LC-1 when the manifold 

pressure and RPM are within +/- 25% of the exact cell location. 
 

For example, if the LC-1 A/F ratio is 13.5/1, the RPM is at 2600 RPM and manifold 
pressure position is at 488 millibars, the value 13.5 would show in the 488 

millibar row 2500 RPM map location. 
 

The TuneBoyTrim program uses these measured values in conjunction with the 

target A/F values to work out the amount of trim required to correct the fuel map. 
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6.5 A/F Target Throttle Position (TP) 
This table contains the target A/F ratio you would like for each point in the map. 

You can set this so that low throttle positions have 13.5/1 and high throttle 

positions have 12.9/1 as shown in the following screen shot: 
 

 
 

 
When the TuneBoyTrim programs Roll-On feature is used these values will be 

compared to the measured values from the “A/F TP (F)” and “A/F TP (R )” tables  
to work out how much to change the trim values by in order to try and bring the 

measured A/F values in line with the target A/F value. 
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7. USING THE TUNEBOYTRIM PROGRAM FOR AUTO-

TUNING 
 
We recommend this be used on an eddy-current brake dynamometer for best 

results. Some common dyno’s are not very good at steady state mapping because 
they are very poor at holding a set RPM. Dyno’s like the Dyno Dynamics, Factory 

Pro, Mainline, Mustang, Superflow etc are much easier to use for this process. 
 

Using the Auto-Tune feature requires use of an Innovate LC-1 wideband O2 
controller. 

 

When the auto-tune feature is turned on the TuneBoyTrim will start to make 
adjustments to the trim values after a set number of A/F samples have been read. 

This option is best used at lower throttle points, up to about 20% throttle. 
To use this option you select the “Auto-Tune” mode then set the dyno to hold a 

fixed RPM. Apply throttle to hold the throttle position within the target zone 
(green dot on target screen). 

 
Once the throttle has been within the target for 10 samples the TuneBoyTrim 

program will calculate the average A/F ratio from these samples and update the 
trim table to try and bring the A/F value in line with the target value for this map 

point. 
 

After the correction is sent to the ECU the program will start to sample again until 
it has 10 samples then it will make another adjustment. 

This process will repeat until you move the throttle out of the target zone. 

 
Tuning this way makes it easy to adjust the steady-state throttle values (low 

throttle values are considered steady-state values). 
 

In this mode you should avoid sudden throttle changes as these unexpected 
changes will trigger the ECU’s throttle enrichment (throttle pump function) and 

this will make the A/F values appear rich. The auto-tune mode should only be 
used on the dyno as the throttle can be controlled on the dyno without sudden 

changes. 
 

7.1 Target Screen 
The target screen can be displayed by selecting the “View” menu and selecting 
“Target Screen” from the drop down menu. You can also display the target screen 
by clicking anywhere in the “Fuel TP Trim (F)” table and hitting the T key on the 

keyboard.   

 
The target screen is also displayed when you select “Roll-On Mode”. 

 
The target screen: 
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You can use the mouse to drag this screen off to the side if you need to see the 
tables.  You can also use the T key to toggle the target screen off and on. 

 
The yellow dot in the target shows how close you are to the most relevant cell in 

the map. 
 

The drop down box marked “O2 sensor type” allows you to select between the 

default 0 to 5 volt output for the LC-1 wideband, or a generic 0 to 5 volt wide 
band. 

The LC-1 wideband by default has 0 volt = 7.35/1 to 5volts = 22.39/1. 
Generic 0-5 volt has 0 volt = 10/1 to 5 volts = 20/1 

 
If you do not have two wide band O2 sensors connected you can remove the tick 

from the A/F sensor value that should be ignored. e.g. A/F Front or A/F rear tick 
boxes in the target screen. This allows you to use the auto-tune mode with a 

single sensor. You can run once with the sensor in the front cylinder, then once 
with the sensor in the rear cylinder. 

   
For example, if the RPM was 2600 and throttle was at 11% the yellow dot will be 

slightly above the horizontal line and to the right of the vertical line. 
If the RPM was exactly 2500 and throttle position was exactly 10% the yellow dot 

would be in the middle of the target. 

 
The target screen always shows the location relative to the closest cell in the map. 

As revs increase the yellow dot will move from left to right, once it goes off the 
target on the right side it will reappear on the left side as it is now showing 

position relative to the next RPM point in the map. 
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The inner green square is +/- 25% of a map point.  A/F values are only recorded 
and used when the yellow square is within this green box. The size of the target 

zone can be adjusted if required in the Process Log File in the TuneBoy Trim 
program. 

 
The target screen will display the current A/F ratio from the Innovate LC-1 

wideband O2 sensor for the front and rear cylinders.  These figures will be 
displayed in colour based on the corresponding value from the Air Fuel Target 

screen. (See following image.) 
 

• If the current A/F is within 0.2 of the target the figures will be shown in 

green. 
• If the current A/F is more than 0.2 over the target the figures will be shown 

in red to indicate a lean situation. 
• If the current A/F is more than 0.2 under the target the figures will be 

shown in blue to indicate a rich situation. 
 

7.2 Engine Temperature 
The engine temperature is displayed to make sure the motor does not overheat 
while tuning the bike.  Note that tuning when the motor is cold will skew the 

results. 
 

• Blue on the engine temp indicates a cold motor, below 75o C (176o F). 
Green indicates the motor is between 75 o C and 100o C (167o F and 212o F).  

(The range can be adjusted if required in the Process Log File in the 
TuneBoy Trim program.  See page 25.)  

 
• Red indicates the motor is over 100o C (212o F) and you should let it cool 

down before making any mapping changes. 

 
7.3 Using the Auto-Tune Feature 
To start the Auto-Tuning feature click the A key on the keyboard or select “Auto 

Tune” from the Options menu.  A marker will appear in the “Auto Tune Enabled” 
(radio button) on bottom right of the target screen. 

 
When Auto-Tuning is enabled the TuneBoyTrim program will make adjustments to 

the map whenever it been within the green target zone for the stable sample 
count (this is 20 by default but can be changed on the “Process Log Screen”), 

This count is used to make sure any throttle enrichment has decayed to 0 before 
the software tries to make adjustments. Once the stable count has been reached 

the software will collect 10 samples for the cell in the map.  Once it has collected 

the 10th sample with a yellow dot still within the green target box, the program 
will compare the average A/F value from these 10 samples against the target A/F 

from the target table. It will calculate the change required to bring the A/F into 
line with the target.  This change is sent to the ECU and the sample count is set 

to zero for that map location.  
 

The program ignores the next 5 samples for this point to allow time for the 
change to be sent and a resulting change in the A/F.  
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If the map point has not changed the software will repeat the process. 
 

If the map point has not changed the software will not need to wait for the stable 
sample count; it will only need to wait for the stable sample count if the throttle 

point has changed. 
   

 
If you have the bike on a dyno that can hold the RPM without too much 

fluctuation you simply need to turn the throttle while watching the yellow dot in 
the target.  Once the yellow dot is within the green square hold the throttle and 

watch the A/F display change until it is green.  Now turn the throttle to the next 

throttle point and the process will repeat. 
 

This type of tuning should only be done for the lower throttle points, up to the 
20% throttle point.  Auto-tuning tuning does not work on the 0% throttle row.  

This must be adjusted manually. 
 

To tune the points above 20% throttle you should use the following method: 
1. Set the dyno to hold at around 2500 RPM; 

2. Set the ramp rate on the dyno to a slow climb.  On a DynoDynamics dyno 
we set this to 6 kph/sec to 10 kph/sec, depending on the throttle amount.  

On a DynoJet® dyno you will need to set the dyno to hold some load once 
you start the run; 

3. With the dyno holding the bike at 2500 RPM turn the throttle to the point 
you want to tune; 

4. Once you have the throttle stable between the lower and upper green lines 

in the target screen you should click the button to allow the dyno run to 
start. 

 
As the ECU runs through the map points the average A/F value will be stored.  

Provided the ramp rate is slow enough the TuneBoyTrim program will collect 
enough samples to adjust the map. 

 
If the “Roll On Mode” has been selected the trim software will calculate the 

required changes as soon as the throttle position drops out of the target zone. 
These changes will be sent to the ECU and the text colour on the A/F screen will 

turn grey. 
 

The screen shot below shows the A/F table after running the bike up through the 
revs at the end of a tuning session: 
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In the image above you can see that most points in the map are green. The text 
colour is grey to indicate that changes have been made, based on these readings. 

The few points that still show red and blue have had a correction made based on 
these values. If the bike was run through these points again the values should be 

on target. In effect this screen shot shows the second to last state of tune. It is 
not necessary to run through again as we can see the A/F values are very good. 

 

Each cell in the Air Fuel Ratio table is coloured to indicate if the point in the map 
is rich (blue), lean (red), or close to the target value (green).  The further from 

the target the darker the colour. 
 

Any point that is obviously incorrect can be cleared/zeroed by clicking on that 
point in the map and hitting the Z key on the keyboard.   

Hitting the Z key moves the value back one level in the A/F screen and moves 0 
into the current value. You may need to hit the Z key twice to actually see 0 in all 

locations in the table. 
 

To make the Air Fuel numbers easier to interpret we have added a graph view for 
the A/F values.  Click the G key on the keyboard to display the A/F Graph screen.   

See screen shot next page: 
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• The green dashed line is the target Air/Fuel line, 
• The solid yellow line is the measured Air/Fuel ratio for the front cylinder, 

• The solid light blue line is the measured Air/Fuel ratio for the rear cylinder, 
• The blue line shows the current position on the line (RPM point). 

 
Only one line of the A/F table is shown at a time.  Use the up and down arrow 

keys on your keyboard to move through the different throttle positions. 

 
You can use the mouse to drag this screen off to the side if you need to see the 

tables.   
 

When you use the Roll-On Mode the graph screen will update after each runs’ 
pass through the revs. This helps the dyno operator see if the A/F values are 

moving in the correct direction. 
 

CAUTION 
N.B If you change the values in the Fuel Trim table the 

corresponding point in the Air Fuel Ratio table will be cleared.  
This makes the text colour grey to indicate that the value 

cannot be used to make corrections. 
This is done to ensure you do not manually adjust the trim map then 

have the program make auto adjustments.  These auto adjustments will 
not be correct if you have already adjusted the Fuel Trim value manually. 
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7.4  Manual Mapping Correction 
If you do not want the program to make the changes in an automated fashion 

you can still use the recorded values to help tune. 

 
If Auto-Tune and Roll-On Mode are both disabled the values will be stored in the 

A/F tables but no corrections will be made to the trims. 
 

In the screen shot below you can see the recorded A/F values and the text is 
black to indicate that the value has not been corrected. 

 

  

 
 

To correct the map rows up to 19% throttle between 2800RPM and 3500RPM you 
need to select the area you want to correct.  Do this by clicking and dragging the 

mouse over the area to be selected as below: 
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Now click the C key on the keyboard.  This will calculate the trim required to bring 

the A/F ratio in line with the target and will update the fuel trim table with the 
required values. 

 
Once the changes are made to the Fuel Trim table the selected area in the Air 

Fuel Ratio table is changed to show the text in grey, indicating that the area has 

been corrected.   
 

On the following screen you can see the corrections that the program has 
calculated.  The changes will be sent to the ECU assuming that the program is 

connected to the motorcycle. The line at the bottom of the screen will show 
“Update Data” until the data has been fully sent to the ECU. 
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The new trims are sent to the ECU and you can now run the bike again and check 

the results.  You should not need to do more than two passes to correct the fuel 
mapping. 

 
The following screen shot shows the A/F table after two passes at each throttle 

point. 
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The next screen shows the final trim values: 
 

 
 

 
The next screen shot shows the A/F graph at the 19% throttle point: 

 

 

 

You can see the yellow and blue lines are now very close to the green target line. 
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8. ROLL-ON MODE TUNING 
The Roll-On Mode is provided to help automate the tuning process. 
 

To use this mode you must have an Innovate LC-1 wideband O2 controller 
connected to the O2 sensor input on the bike or connected to the Serial In on the 

WB-01. 
 

If the LC-1 is connected to the O2 sensor plug on the motorcycle you should 
make sure the output of the LC-1 is set to give 0 volts for 10/1 A/F ratio and 5 

volts for 20/1 A/F ratio. 

 
Any wide band O2 controller can be connected providing it can output the 0-5volt 

signal. 
 

1. To enable the roll-on mode go to the “Options” menu and select “Roll-On”. 
This will display the target screen and put a marker (radio button) in “Roll-

On Mode” on the target screen. If you only have one wide band O2 sensor 
you should only have a tick on the target screen in the A/F display that the 

wide band is connected to (A/F Front or Rear). This will make sure the value 
from the second O2 sensor input is ignored. 

 
2. With this mode selected you should set the dyno to hold at the desired 

starting RPM then turn the throttle to the throttle row you want to tune.  
Use the target screen to get the throttle position as close to the horizontal 

line as you can. Once the throttle has been stable in the throttle zone for a 

number of samples the A/F value will be updated in the table. The number 
of samples can be adjusted in the Process Log File screen. 

 
3. Now release the hold on the dyno to let the revs increase.  It is best to use 

a slow ramp rate at low throttle and a faster rate at high throttle.  Hold the 
throttle steady until the revs climb as far as they can and then release the 

throttle. 
 

4. When you release the throttle the program will calculate the correction 
required and make the changes to the trim table.  These changes will get 

sent to the ECU as soon as they are made. 
 
NOTE: 

• For the first pass at a given throttle row the program will apply the full trim 

amount. 

• For the second pass at a given throttle row the program will again apply the 
full trim amount.   

• For the third pass at the same throttle row the program will apply half the 
calculated correction value. 

• For any extra passes the program will step 0.5% in the direction required. 
 

This process prevents the “yo-yo effect” you can get with auto-tune options. 
 

Two passes at any throttle row should be enough to get the A/F values into the 
green zone.  
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9. LOADING THE TRIM FILE ONCE TUNING IS 

COMPLETE 

 
1. Go to the File menu and select “Reflash ECU”. The program will prompt you 

to save the trim file.  

 
2. Once the file is saved the TuneBoyTrim program will close and the 

FlashMitsubishi program will start. The FlashMitsubishi program will open 
the last tune flashed into the ECU and apply the trim file you have just 

saved.  

 
3. Now click the “Re-flash ECU” button to load the changes into the ECU. 

 
4. Once the re-flash is completed you should start the trim program and check 

that the correct numbers are shown when the trim file is read from the ECU. 
 

 

10. REAL-TIME IGNITION MAP CHANGES 
 

CAUTION 
Adjusting ignition maps in real-time should only be done on 
a dyno by a trained dyno operator.  This should also only be 

done on a dyno that can show HP or torque while the dyno 
is holding a set RPM (most DynoJet® dyno’s cannot do this). 

 
1. Start the TuneBoyTrim program and open the target screen (T). 

 

2. Turn on Auto-Tuning (click the Auto-Tune Enabled radio button on the 
target screen). This will make sure the A/F ratio is corrected as you adjust 

the ignition mapping. 
 

3. Now select the “Ignition Trim” table. 
 

4. Set RPM to hold at one of the RPM points in the map and turn the throttle 
until the yellow dot is inside the green square.  If you hit the spacebar on 

the keyboard this will make the current edit cell follow the point shown in 
the target. 

 
5. Use the PageUp or PageDown to alter the ignition trim value and watch 

the HP reading on the dyno. 

 
6. Increase the ignition trim until the HP on the dyno stops increasing, and 

then reduce the ignition trim until you have the value that gives the best HP 
for the least ignition advance. 

 
While you are adjusting the ignition advance the TuneBoyTrim program will make 

sure the A/F ratio stays on target. 
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Using this method to map ignition at lower throttle points can make big 
improvements to the throttle response and fuel economy of the motorcycle. 

Again, once the changes have been made the trim map must then be saved and 
loaded into TuneEdit to reflash into the ECU. 

 

 

11. AUTO-THROTTLE FEATURE 
 
For dyno operators we have added the ability to control the throttle from the PC. 

To do this you set the dyno to hold RPM then click on the end throttle and RPM 

point in the map, for example 4500RPM and 20% throttle. 
 
Now hit the F5 key on the keyboard. 

 

The throttle on the motorcycle will go to 20% until the RPM reaches 4500 RPM, at 
this point the throttle will close. 

 
This allows accurate throttle control for dyno-tuning. 

 
 

 

12. HIGH SPEED DATA-LOGGING 
 

To allow data-logging the bike must be running. 

 
Go to the “Tools” menu in the TuneBoyTrim software and select “Start Logging”. 

 
Create a file name and select “Save”.   

 
You can still make changes and use all normal functions in the program whilst 

data-logging..  
 

When you stop the TuneBoyTrim program it closes off the data-log file. 
 

The data-log file is in a raw data format so it can only be processed by the 
TuneBoyTrim program 

 
The data-logging can be used to trim the bike after collecting data from a ride. 

 

12.1  Processing a Log File 
 
1. Hit the ‘T’ key on the keyboard to display the target screen. If you only 

have one A/F sensor connected you should make sure you only have a tick next 
to the A/F number for the cylinder that had the sensor when you collected the log. 

 
The following screen shot shows the target screen if you have the A/F sensor 

connected to the front cylinder. 
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2. Now go to the “Tools” menu and select “Process log file”.   

 
The following screen is displayed: 

 

 
 
3. Click the “Select file” button and select the log file you have created. 

 
4. Now click the “Process log file” button.  The software will process all the 

records in the file and fill in the A/F tables. 
 

The following screen shot shows the A/F table for the front cylinder after 
processing the log file: 
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5. Now with the A/F tables filled in you can select the areas that need 
correcting and hit the C key on the keyboard to correct the fuel trim table. 

 
Once you correct an area of the map the text colour in this area will change to 

grey.  This is shown in the next screen shot: 
 

 
 
The next screen shot shows the trim table with the calculated trims: 
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6. To reflash the ECU with this new trim table you go to the “File” menu and 
select “Reflash ECU”. You will be asked to save the trim file then the TuneBoyTrim 

program will close and the FlashMitsubishi program will start. 
 

7. Click the “Reflash ECU” button. 
 

Once this is complete you can record another log file to check the results of the 

changes. 
 

It is important that any changes made are applied to the trims that are in the 
bike at the time the log was recorded; if not, the corrections will be incorrect. 

 
By default the TuneBoyTrim program will open the last trim file that was saved. 

 
8. Once you are happy with the trims on one cylinder you can move the A/F 

sensor to the second cylinder and record a data log from the second cylinder. 
 

The “Process log” screen allows you to adjust the settings used to process the log 
file.  

 

12.2 Settings 

 
The “Stable throttle for number of samples” tells the software how many 

records must be read with the throttle between the lower and upper green line in 
the target screen before A/F records are collected. This is used to make the 

software ignore any A/F values recorded when the throttle is opening or closing 
as these values will be richer or leaner that the steady state values. 
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If you adjust this number to a smaller number it will show more values in the A/F 
table but the values may show leaner or richer than the actual A/F at steady 

throttle. 
 
The “RPM and throttle zone %” controls the size of the green square in the 

target screen. If you make the number smaller you will only get values in the A/F 

table if the throttle and RPM are closer to the point in the table. 
 

Making this number bigger will fill in more of the A/F table but the numbers may 
be less accurate as they can be further from the actual point in the tables. 

 
The “Update in real time” tick box will make the program show the values as 

they are processed. 

 

13. CRUISE CONTROL 
 

The Cruise Control feature adds full electronic cruise control to the ECU.  
 

In its most basic form this allows the start button to be used to turn on and set a 
cruise speed. 

 
Cruise control cannot be activated until the motorcycle speed is over 40 

kph. 
Cruise control cannot be activated if the clutch is pulled in or the brakes 

applied. 

 
Once the cruise control is active the ECU will monitor the speed of the motorcycle 

and adjust the throttle to hold the speed that the motorcycle was doing at the 
time the cruise control was set. 

 
Cruise control will disengage under the following conditions: 

1. If the rider applies the front or rear brake, 
2. If the clutch is pulled in, 

3. If the engine RPM goes past 6500RPM, 
4. If the throttle required to hold speed reaches 50% throttle. 

 

13.1 Activating Cruise Control 
To turn the cruise control on you simply start the motorcycle then hold the start 

button pushed-in for three seconds. This will turn the feature on and at the same 
time the throttle will give a small blip to indicate that the cruise control is on. 

 
You can turn cruise control on while riding by holding the start button for three 

seconds. The throttle will not blip while the bike is moving but the cruise control 
will still be turned on. 

 
Once the cruise control is turned on you activate the cruise mode by pressing the 

start button. When you press the start button you will notice a slight change in 
throttle and the motorcycle will drop speed slightly before the ECU takes control. 

At this point you can roll-off the throttle completely and the bike will maintain 

speed by itself. 
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Under most riding conditions the cruise control will maintain speed to within 2-

3kph of the set speed. 
 

If you need to overtake a slow vehicle you can apply throttle. This will override 
the cruise control and allow you to increase speed. Once you back the throttle off 

the cruise control will take over as soon as the speed drops back to the previously 
set cruise speed. 

 
If you need to increase the set cruise speed you do not need to disengage, simply 

accelerate to the new speed and press the start button again. 

 
If you need to decrease speed simply touch the brakes then press the start 

button when the bike slows to the desired speed. 
 

If you have purchased a key for both tuning and cruise control you can fit the 
optional buttons for the cruise control. These connect to the rear O2 sensor for 

the Multistrada or the front O2 sensor for the Diavel. 
 

The buttons allow the following extra function: 
Cruise speed can be increased by pressing the up button or decreased by 

pressing the down button. 
If the cruise control is not active either button can be used to set the cruise. 

 
 

13.2 Heated Grips 
 
If you have the heated grips on a Multistrada 1200 these will function as normal.  

 
N.B. The cruise function may take over if the bike speed is over 40kph. 

To prevent the cruise control taking over while adjusting the heated 
grips we recommend pulling the clutch in while you adjust the heated 

grip settings.  

 
The cruise control will not be activated if the clutch is pulled in. 
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14. LIST OF KEYBOARD COMMANDS 
 
A  Turns Auto-Tune mode on. Target screen must be displayed. 

 
C Corrects the selected area of the Air Fuel Ratio table.  A/F Ratio table 

must be selected. 
 
G  Displays A/F Graph screen. 

 
R  Turns Roll-On-Mode on or off. Target screen must be displayed. 

 
T  Shows the target screen. 

 
Z  Zeroes (clears) the selected area of the current table. On the A/F 

table you may need to hit the ‘Z’ key twice to fully clear the values. 
 
Ctrl-S Saves the trim map. The date and time are added to the file name 

automatically.  This is a good way to make a save point that is easy 

to go back to. 
 
SpaceBar This will make the green edit square follow the current TP and RPM. 

  Hit the SpaceBar again to turn this function off. 
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APPENDIX A: 
 
 

TuneBoy Advance WiFi Kit 
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APPENDIX B: 

 
 

 

 
 

 
 

 


